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About This Document
This manual is intended for integators building the AXIS 
282/AXIS 282A into a product or system, and 
administrators and users of the product or system that 
includes the AXIS 282/AXIS 282A as a component. The use 
of "AXIS 282/AXIS 282A" and "Video Server" thoughout 
this manual refers to the AXIS 282/AXIS 282A as an 
integrated component of an end product or system. This 
manual applies to AXIS 282/AXIS 282A firmware release 
4.30. It includes instructions for integrating, using and 
managing the AXIS 282/AXIS 282A on your network. 
Previous experience of networking will be of use when 
installing and using this product. Some knowledge of UNIX 
or Linux-based systems would also be beneficial for 
developing shell scripts and applications. Later versions of 
this document will be posted to the Axis Website 
(http://www.axis.com/techsup/index.htm) as required. Also, 
see the online help for the AXIS 282/AXIS 282A available 
via its Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

Legal Considerations
Camera and audio surveillance can be prohibited by laws 
that vary from country to country. Check the laws in your 
local region before using this product for surveillance 
purposes. This product includes one (1) MPEG-4 decoder 
license. To purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses, and can radiate radio 
frequency energy. The AXIS 282/AXIS 282A is delivered as 
a component for the sole purpose of being integrated into 
an end product or system. The foregoing implies an 
obligation on behalf of the integrator (Buyer of the AXIS 
282/AXIS 282A component) to obtain any approvals from 
authorities or governmental bodies that may be required for 
the lawful use of the finished product or system, which 
includes the AXIS 282/AXIS 282A as a component. Resale 
and use of the AXIS 282/AXIS 282A on a stand-alone basis 
is not allowed. For the final products and solutions, 
responsibility for fulfillment of safety, EMC, and other 
regulatory standards controlled by law, is therefore passed 
on to the integrator (Buyer of the AXIS 282/AXIS 282A 
component).

Liability
Every care has been taken in the preparation of this 
manual; Please inform your local Axis office of any 
inaccuracies or omissions. Axis Communications AB 
cannot be held responsible for any technical or typographical 
errors and reserves the right to make changes to the product 
and manuals without prior notice. Axis Communications AB 
makes no warranty of any kind with regard to the material 
contained within this document, including, but not limited to, 
the implied warranties of merchantability and fitness for a 
particular purpose. Axis Communications AB shall not be liable 
nor responsible for incidental or consequential damages in 
connection with the furnishing, performance or use of this 
material.

Trademark Acknowledgments
Ethernet, Internet Explorer, Linux, Microsoft, Mozilla, OS/2, 
UNIX, Windows, WWW are registered trademarks of the 
respective holders. QuickTime™ is a trademark of Apple 
Computer, Inc., registered in the U.S. and other countries. Java 
and all Java-based trademarks and logos are trademarks or 
registered trademarks of Sun Microsystems, Inc. in the United 
States and other countries. Axis Communications AB is 
independent of Sun Microsystems Inc. UPnP™ is a certification 
mark of the UPnP™ Implementers Corporation.

Support Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. 

Search by product, category, or phrases
• report problems to Axis support staff by logging in to your 

private support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 282/AXIS 282A uses a 3.0V CR2032 Lithium battery 
as the power supply for its internal real-time clock (RTC). This 
battery will, under normal conditions, last for a minimum of 5 
years. Low battery power affects the operation of the RTC, 
causing it to reset at every power-up. A log message will appear 
when battery replacement is required.

The battery should not be replaced unless required!
If the battery does need replacing, observe the following points:

Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 
   recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 
   instructions.
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Revision 1.0
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Product Description
This manual is applicable for the following Axis Video Servers:

• AXIS 282: 1-port bare board video server
• AXIS 282A: 1-port bare board video server, including 2-way audio

The information provided in this manual applies to both models, unless otherwise 
indicated.

The AXIS 282/282A is a small form factor video server board designed to be built into 
domes, fixed view cameras, PTZs, analog devices, etc., and is fully featured for security 
surveillance and remote monitoring needs. The AXIS 282/282A is based on the AXIS 
ETRAX 100LX network optimized system-on-a-chip (SOC), and the AXIS ARTPEC-2 
compression chip. The AXIS 282/282A can digitize one analog video source and make it 
available on the network as real-time, full frame rate Motion JPEG and/or MPEG-4 video 
streams. 

The AXIS 282/282A is equipped with RS-232 or RS-485 ports for connecting third party 
PTZ systems. It also has 1 alarm input and 1 alarm output, which can be used to connect 
various third party devices, e.g., door sensors and alarm bells. 

The AXIS 282A has a Line/Mic In (mono), via the internal connector I/O pins, for 
connecting an external microphone or other source producing a line level signal. An active 
speaker with a built-in amplifier can be connected to Line Out (mono) to enable two-way 
communication. Audio communication can be bi-directional (full-duplex), push to talk 
(half-duplex) or in one direction only (simplex). 

Up to 20 viewers can access the AXIS 282/282A simultaneously when using Motion JPEG 
and MPEG-4 unicast. Each MPEG-4 viewer requires a separate MPEG-4 decoder license, of 
which one is included. Additional licenses can be purchased separately from your Axis 
dealer. If using other clients to view the MPEG-4 video stream, no further MPEG-4 decoder 
licenses are required.

Video can be viewed in 5 resolutions (up to 4CIF), and image compression is configurable. 
The AXIS 282/282A contains support for video motion detection, which allows the unit to 
trigger on activity in the video image, and advanced scheduling tools which can also be 
used to trigger an event. As the AXIS 282/282A is designed for use in security systems, it 
is equipped with several security features, such as IP address filtering, several user levels 
with passwords and HTTPS.

The AXIS 282/282A has a built-in web server, providing full access to all features through 
the use of a standard browser. The built-in scripting tool allows basic applications to be 
created, providing basic surveillance solutions. For advanced functionality, the Video 
Server can be integrated via the use of the AXIS HTTP API (see www.axis.com/developer).
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AXIS 282/282A Top

34-pin header

The AXIS 282/282A has 34-Pin Header for several connections including:

• Serial port, configurable as RS-232 or RS-485, which is typically used for con-
necting Pan/Tilt/Zoom devices.

• Video in and out connections. 
• Audio in and out connections.
• LED outputs
• An auxiliary connection point for DC power.

See The Terminal I/O Connector, on page 58 and  The 34-Pin Header, on page 59 for more 
information.

AXIS 282/282A Front

Flash button

Terminal block

Control button
Network connector

Terminal block - The front of the AXIS 282/282A has one each in- and out connector, and 
a power and GND connection. 
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Control button - Press this button to restore the factory default settings, as described in 
Resetting to the Factory Default Settings, on page 57, or to install using AXIS Internet 
Dynamic DNS Service (page 14).

Flash button - The AXIS 282/282A has a flash button. However, it is only used for 
firmware programming in the factory. It is not used when upgrading the firmware!

Network connector - The AXIS 282/282A connects to the network via a standard network 
cable, and automatically detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet).

AXIS 282/282A Bottom

Status LED

Network LED

Power LED

LED indicators - After completion of the startup and self-test routines, the multi-colored 
Status, Network, and Power idicators flash as follows:

Unlit When configured for “no flash” on camera access.

Green Steady for normal operation. Can be configured to flash green at intervals 
whenever the camera is accessed. See the online help for more information.

Amber Steady during startup, reset to factory default or when restoring settings.

Red Slow flash for failed upgrade.

Unlit No connection

Green Steady for connection to a 100 Mbit/s network. Flashes for network activity.

Amber Steady for connection to a 10 Mbit/s network. Flashes for network activity.

Red Flashes rapid red for hardware error, together with the Status indicator

Green Normal operation

Amber Flashes green/amber during firmware upgrade

Status

Network

Power
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Integration of the AXIS 282/282A into end products or systems
Electrical integration of the AXIS 282/282A is done through any of the connectors 
described in the previous sections above. 

Mechanical integration may be done through the 4 mounting holes on the AXIS 282/282A, 
shown in the figure below.

The video server measures 82mm in length from the outside edge of the Terminal 
Connector, to the top of the AXIS 282/282A. The width of the AXIS 282/282A is 79mm.

Connector Connector

Connector

Connector

79mm

82mm

Terminal Connector

The height of the AXIS 282/282A, from the top of the network connector to the bottom of 
the control button is 19 mm as seen in the figure below.

Control button

19mm

Network connector
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Installation 

Installation Methods

The AXIS 282/282A is designed for installation on an Ethernet network. This involves 
assigning it an IP address, either manually or via an automated network service (DHCP). 
Select one of the following procedures depending on your network: 

• In Windows, use AXIS IP Utility to discover a dynamic IP address, or to set the IP address 
manually.

• If your network uses a DHCP server, view its administration pages to discover which IP 
address has been assigned to your AXIS 282/282A. 

• If your network uses a DHCP server and your computer is running UPnP™, the AXIS 
282/282A will automatically be detected and displayed on your screen. See page 11.

• Assign an IP address manually using the ARP/Ping method, as described on page 12.
• If your network has an Internet connection (with no HTTP proxy) and uses a DHCP server 

to assign IP addresses, use the One-Click installation procedure. See page 14.

Notes: • The AXIS 282/282A has a default IP address: 192.168.0.90
• DHCP is enabled by default in the AXIS 282/282A
• UPnP™ is enabled by default in the AXIS 282/282A

AXIS IP Utility

AXIS IP Utility is a free Windows 
application that discovers and displays 
Axis devices on your network. The 
application can also be used to 
manually set a static IP address. 
Download AXIS IP Utility from the 
support pages at: 
www.axis.com/techsup/software

Automatic discovery

1. Check that the network and power cables are connected to the AXIS 282/282A.

2. Start AXIS IP Utility. When the AXIS 282/282A appears in the window, double-click it 
to open the home page. 

Set the IP address manually

If the AXIS 282/282A does not appear in the window, click the Refresh button to try 
again. If it still does not appear, set the IP address manually. 

1. Acquire an unused IP address. AXIS IP Utility detects the subnet your computer is 
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connected to. The AXIS 282/282A must be installed on the same network segment.

2. Click the button “Set IP address using serial number” and enter the serial number and 
the IP address for the AXIS 282/282A. The serial number is located on the memory 
capsules on top of the AXIS 282/282A.

3. Click the Set IP button and then restart the AXIS 282/282A (within 2 minutes).

4. Click View Home Page to access the AXIS 282/282A Web pages.

5. Enter a password for the root user (administrator).

6. If required, accept the installation of AMC onto your workstation.

Notes: • AXIS IP Utility can also be used to change the IP address of a previously discovered Axis device.
• AMC (AXIS Media Control) must be installed to view live video in Microsoft Internet Explorer. If your 

working environment restricts additional software components, you can configure your AXIS 282/282A to 
use a Java applet for updating the images. See the help file Live View Config > Layout > Default Viewer for 
Internet Explorer, or use another supported Web browser, see Technical Specifications, on page 66. 

7. The installation is now complete. Proceed to Using the Video Server, on page 15. 

UPnP™ 

UPnP functionality is enabled by default in the AXIS 282/282A. If also enabled on your 
computer (Windows ME or XP), the video server will automatically be detected and a new 
icon will be added to “My Network Places.” Click this icon to access the AXIS 282/282A. 

Note: 

To install the UPnP service on your computer, open the Control Panel from the Start Menu and select 
Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Services 
section. Click Details and then select UPnP as the service to add. 

The serial number (S/N) is located on the memory capsules on top off the AXIS 282/282A.

UPnPTM is a certification mark of the UPnPTM Implementers Corporation.
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ARP and Ping in Windows
Assign your product a unique IP address from a computer on your network as follows:

1. Acquire an unused IP address for the AXIS 282/282A from your network 
administrator.

2. Connect the AXIS 282/282A to the network using a standard network cable.

3. Find the serial number (S/N) located on the memory capsules on top of the AXIS 
282/282A.

4. From a computer on your network, open a Command Prompt, i.e. from the Windows 
Start menu, select Run... and type cmd (command in Windows 98/ME). Click OK.

5. Enter the commands:
           Syntax:

   Example

6. Start/restart the AXIS 282/282A. This must be done no later than 2 minutes after 
entering the ARP and Ping commands.

7. When ‘Reply from 192.168.0.125: ...’ is displayed (approximately 10-15 seconds), type 
Ctrl+C to stop Ping.

8. Start a browser and enter the IP address in the Address/Location field.

9. Press Enter.

10. Enter a password for the root user (administrator).

11. If required, accept the installation of AMC onto your workstation.

Note: AMC must be installed to view live video images in Microsoft Internet Explorer. If your working environ-
ment restricts additional software components, you can configure your AXIS 282/282A to use a Java applet 
for updating the images. See the help file under Live View Config > Layout > Default Viewer for Internet 
Explorer for information. Or use another supported Web browser, see Technical Specifications, on page 66.

12. The installation is now complete. Proceed to Using the Video Server, on page 15.

arp -s <IP address> <Serial number> 
ping -l 408 -t <IP address>

Note: The ping command is 
followed by -l (lower case L)
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ARP and Ping in UNIX/Linux
Assign your product with a unique IP address from a computer on your network, as 
follows:

1. Acquire an unused IP address for the AXIS 282/282A from your network 
administrator.

2. Connect the AXIS 282/282A to the network using a standard network cable.

3. Find the serial number (S/N) located on the memory capsules on top of the AXIS 
282/282A..

4. Start/restart the AXIS 282/282A. This must be done no later than 2 minutes after 
entering the ARP and Ping commands.

5. Close the ARP/Ping session when ‘Reply from 192.168.0.125: ...’ (or similar) is 
displayed (approximately 10-15 seconds).

6. Start a browser and enter the IP address in the Address/Location field.

7. Press Enter.

8. Enter a password for the root user (administrator).

9. The installation is now complete. Proceed to Using the Video Server, on page 15.

Syntax:

arp -s <IP Address> <Serial number> temp 
ping -s 408 <IP address>

Example:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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AXIS Internet Dynamic DNS Service
The AXIS Internet Dynamic DNS Service is a free service provided by Axis. The service 
allows you to quickly and simply install your video server, which then receives a static 
name (DNS name) and a dynamic IP address. More information about the AXIS Internet 
Dynamic DNS Service is available at www.axiscam.net

The video server can be unregistered from the service at any time.

Please visit www.axiscam.net for more details on the AXIS Internet Dynamic DNS Service.

Requirements
Using the AXIS Internet Dynamic DNS Service requires an Internet connection that does 
not require a proxy server for HTTP access. A DHCP server in the network for assigning IP 
addresses is recommended.

Installation Procedure

1. Connect the AXIS 282/282A to your local network, using a standard network cable.

2. Connect power to the video server.

3. Wait for the Status indicator on the front of the video server to show a steady green, 
whereupon it will have received a dynamic IP address from a DHCP server on your 
network.

4. Wait 60 seconds and push the control button on the front panel once. The Status 
indicator on the front of the video server will flash green while it connects to the AXIS 
Internet Dynamic DNS service. When the registration process is complete, the indicator 
will return to steady green.

5. Visit www.axiscam.net where you will be guided through the remainder of the 
installation. Please have the serial number of your product ready and follow the 
instructions on the screen.

6. Enter a password for the root user (administrator).

7. If required, accept the installation of AMC onto your workstation.

Note: AMC must be installed to view live images in Microsoft Internet Explorer. If your working environment 
restricts additional software components, you can configure your AXIS 282/282A to use a Java applet for 
updating the images. See the help file under Live View Config > Layout > Default Viewer for Internet 
Explorer for information. See also the Technical Specifications, on page 66.

8. The installation is now complete. Proceed to Using the Video Server, on page 15.

Please note that this procedure will send the AXIS 282/282A’s IP address, firmware version, product type 
and serial number to the Axis Internet Dynamic DNS Service. No personal information will be transferred.

The serial number (S/N) is located on the memory capsules on top off the AXIS 282/282A.
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Using the Video Server
The AXIS 282/AXIS 282A can be used with most standard operating systems and browsers. 
The recommended browser is Internet Explorer with Windows, and Mozilla with other 
operating systems. See also the Technical Specifications, on page 66.

Note: For information on installing the Video Server, please refer to Installation, on page 
10.

Accessing the Video Server
1. Start your browser. 

2. Enter the IP address or 
host name of the AXIS 
282/AXIS 282A in the 
Location/Address field 
of your browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your browser. 
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Notes: •To view streaming video in Microsoft Internet Explorer, you must set your browser to allow the 
AXIS Media Control (AMC) to be installed on your computer. AMC also provides an MPEG-4 
decoder for viewing MPEG-4 video streams. This decoder is installed the first time an MPEG-4 
video stream is accessed. Please note that the product administrator may have disabled the 
installation of the decoder, as a license is required for each instance. See page 35 for more 
information.

•If your workstation restricts the use of additional software components, the AXIS 282/AXIS 
282A can be configured to use a Java applet for updating JPEG images. Please see the online 
help for more information.

The Live View page
If your AXIS 282/AXIS 282A has been customized to meet specific requirements, the 
buttons and other items described below may or not be displayed on the Live View page. 
The following provides an overview of each available button:

To resize the displayed image, click the View Size buttons: half-size 
(x1/2), full-size (x1), x2 or x4. This will not change the resolution of the 
image (not available in Sequence Mode).

 
The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed. 

The Output buttons control an output directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds. 
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view 
from 2 or more video sources at set intervals.

From the Source list, select the desired video image(s). The list can 
contain internal video sources, external video sources, or PTZ presets.

The Action buttons trigger an event directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.
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Audio controls for AXIS 282A

Note that these AMC toolbar functions can also be accessed by right-clicking in the image.

For information on using Pan/Tilt/Zoom controls, please see page 42.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in on your 
computer.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet 
Explorer only and displays the following buttons:

The Play/Stop buttons start and stop the media stream.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on your keyboard to 
cancel full screen view.

Click the Speaker and Microphone buttons to switch the sound off and on for the 
speaker and microphone, respectively.  
 

Use the slider to control the volume on the speaker and microphone. 
The volume can be set between 0 and 100. 

When using Half-duplex mode this button toggles between allowing you to speak 
and listen. The first icon indicates that you can talk and the speaker attached to the 
Video Server will play your voice. The second indicates that you will hear audio 
from the Video Server, but no audio will be sent to any web clients. When in 

simplex talk mode, the icon toggles between allowing you to speak and is dimmed when 
you do not want other clients to receive any audio.
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Video and Audio Streams
The AXIS 282/AXIS 282A provides several different video and audio stream formats. The 
type to use depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 282/AXIS 282A provides access to Motion JPEG and 
MPEG-4 video and audio streams, as well as to single JPEG images. Other applications and 
clients can also access these video and audio streams/images directly, without going via 
the Live View page. 

Video Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to each and every individual image contained in the 
stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high-quality video streams at less than 1 Mbit/s. 

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 282/AXIS 282A provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263 
• Advanced Simple - in Axis products, this sets the coding type to MPEG-4 Part 2

AMC (AXIS Media Control) supports both object types, whilst e.g. QuickTime™ requires the 
Simple object type.

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable 
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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Notes: •MPEG-4 is licensed technology. The AXIS 282/AXIS 282A includes one license for the decoder 
required for viewing in AMC. Installing additional unlicensed copies of this decoder is prohib-
ited. To purchase more decoder licenses, contact your Axis reseller.

•All clients viewing the MPEG-4 stream must use the same image settings.

Audio Stream Types
The three stream types for audio are: 

• G.711 - International standard for encoding wired-telephone audio. Uses PCM samples 
to compress audio where higher signal values are compressed more than lower values. 
In Axis products, this sets the coding type to µ-law 64 kbit/s.

• G.726 - Uses PCM samples to code the difference between samples (ADPCM). Reduces 
bandwidth without losing too much useful audio. In Axis products, this sets the coded 
bitrate to 24 or 32 kbit/s.

All stream types are ITU-T standards and operate on frequencies up to 4 kHz.

MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Real-Time Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real-Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.
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How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network. Setting the preferred method(s) is 
done in the control applet for AMC, which is found in the Windows Control Panel. When 
this has been set, AMC will test all the selected methods in the specified order, until the 
first functioning one is found.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first 
consideration for live video, especially when it is important to always have an up-to-date 
video stream, even if some images do get dropped. This can be configured as multicast or 
unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video 
traffic on the network until a client connects and requests the stream. However, if more 
and more unicast clients connect simultaneously, the server will at some point become 
overloaded. There is also a maximum of 20 simultaneous viewers to be considered.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) and 
audio from the AXIS 282/AXIS 282A is to use the AXIS Media Control (AMC) in Microsoft 
Internet Explorer in Windows. This ActiveX component is automatically installed on first 
use, after which it can be configured by opening the AMC Control Panel applet from the 
Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.
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Other methods of accessing the video stream
Video/images from the AXIS 282/AXIS 282A can also be accessed in the following ways:

• If supported by the client, the AXIS 282/AXIS 282A can use Motion JPEG server push 
to display video. This option maintains an open HTTP connection to the browser and 
sends data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The 
paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/media.amp

Note: <ip> = IP address.

Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, it is not 
guaranteed to work in all cases. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It 
may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip>/mpeg4/media.amp 

This path is for all supported methods, and the client will negotiate with the AXIS 
282/AXIS 282A to determine exactly which transport protocol to use.

Note: <ip> = IP address.

Audio transmission methods
For the AXIS 282A, the audio stream can be accessed in the Live View page when viewing 
either Motion JPEG or MPEG-4. 

Using Motion JPEG
The basic transmission method of audio used in conjunction with Motion JPEG video 
streaming is transmission over HTTP. The video and audio streams are not synchronized 
when using Motion JPEG so the streams may be slightly out of sync. The latency in any 
stream should be low, but this will depend on the network infrastructure.
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Using MPEG-4

When using MPEG-4, audio is streamed using the same protocol as the video stream.

When audio is transmitted using MPEG-4, the Axis product sends synchronization 
information along with the streams to the client that is performing the synchronization. 

Note: Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.

Accessing the Audio Streams
In addition to accessing audio in the Live View page using AMC, audio from the AXIS 
282A can also be accessed in the following ways:

HTTP-API
You can read about accessing audio for the other protocols through the HTTP-API at 
http://www.axis.com/techsup

QuickTime/Windows Media Player
It is possible to use QuickTime and Windows Media Player to listen to the audio stream 
using the same methods to access video streams.
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Configuring the Video Server
This section describes how to configure the AXIS 282/AXIS 282A and is intended for:

• administrators, who have unrestricted access to all the Setup tools
• operators, who have access to the Video & Image, Audio, Live View Config and Event 

Configuration settings.
The AXIS 282/AXIS 282A is configured from the Setup link, in a standard browser (see 
also the Technical Specifications on page 66).

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a browser.

1. Start the browser and enter the IP address or host name of the AXIS 282/AXIS 
282A in the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Setup tools
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Video & Image Settings
The following descriptions show examples of the available features in the AXIS 282/AXIS 
282A. For details of each setting, please refer to the online help available from each page. 
Click to access the online help.

Image Settings

Image Appearance

Modify the Image Appearance to optimize the video images according to your 
requirements.

All configuration of images and overlays will affect the performance of the Video Server, 
depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
• Rotating the image 90 or 270 degrees will lower the maximum frame rate
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See also the specifications for frame rates and bandwidth on page 70. 

Text Overlay Settings

Include date, time and/or text of your choice to be viewed on the image. The color of the 
text may be set to white or black, while background color may be set to white, black, 
transparent or semitransparent. The position of the text is set either to the top or the bot-
tom of the image. 

Video Stream

The Maximum video stream time can be set as Unlimited, or a maximum stream time per 
session in seconds, minutes or hours can be defined. When the set time has expired, a new 
stream can be started by refreshing the page in the Web browser. Note that the maximum 
video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

Test

For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Video Source Settings
These settings allow you to eliminate any black borders surrounding the image, by making 
Offset adjustments. See the online help for more information.

Select the physical connector the video source is connected to, composite video or Y/C 
(s-video).
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Overlay/Mask Settings

Date &
Time

image
Overlay

Mask

Overlay/Mask Type

Overlay/Mask Type allows you to 
place an overlay, or up to three 
privacy masks over the video 
image:
• Upload and place an image as 

an overlay - usually used to 
provide extra information in 
the video image.

• Place up to three privacy masks 
- up to 3 configurable masks 
can be used to conceal different 
areas of the video image.

Selecting the overlay/mask type from the menu will display further settings available for 
the selected type. See the online help for further information.

Note: If you need to see an area of the video that is covered by an overlay or mask, a privacy mask cannot be 
bypassed. An overlay image, however, can be bypassed with the help of the AXIS HTTP API.

Upload and use an overlay

To upload an overlay image to the camera:

1. Select Uploaded image as overlay in the drop-down list for Overlay/Mask Type. 
New options appear.

2. In the field Upload own image, click the Browse button and locate the image file 
on your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

To use an already uploaded image:

1. Select an uploaded image from the Use image drop-down list.

2. Place the image at the required location by entering the x and y coordinates.

3. Click Save.
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Overlay image requirements:

Overlay image limitations:
• The maximum overlay image size supported by the AXIS 282/AXIS 282A is the same as 

the maximum image resolution. See Technical Specifications, on page 66.
• When a text overlay is also used, this reduces the amount of space available to the 

overlay image. To keep the text readable at lower resolutions, the text overlay occupies 
proportionally more of the image at lower resolutions. 

• If the overlay is initially positioned so that part of it is outside the video image, it will 
be relocated so that it appears over the video image, i.e. it is always the entire image 
that is displayed.

Please see the online help for more information.

Use a Privacy Mask

To use privacy masks to hide different areas of the video image:

1. Select Configurable areas as privacy mask in the drop-down list for 
Overlay/Mask Type. New options appear.

2. Enter the (x,y) coordinates of the top left hand corner of the mask, and the height 
and width to define the masks’ placement and size.

3. Select the privacy masks’ color: black, grey, white, or red.

4. Click in the box beside Enable to enable one or more of the masks you have 
defined and click on Save.

Image Formats Image Size

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.



 28 AXIS 282/AXIS 282A - Video & Image Settings
Advanced - MPEG-4 Settings
Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help.
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Audio (AXIS 282A only)
The AXIS 282A can transmit audio to other clients using an external microphone and can 
play audio received from other clients by attaching a speaker. The Setup page for the AXIS 
282A has an additional menu item called Audio, that allows different audio configurations 
to be set up, e.g. full duplex, half duplex and simplex.

Note: The speaker attached to the audio output of the AXIS 282A must have a built-in 
amplifier, e.g. some PC speakers.

Audio Settings
This section describes how to configure the basic audio settings for the AXIS 282A, e.g. set 
the communication mode and adjust the sound levels in the microphone and speaker 
connected to the camera. 

Enable Audio

Check the box Enable Audio to enable audio functionality.

Audio Channels

There are two mono audio channels between the AXIS 282A and other clients, one for 
receiving audio and one for transmitting audio. Each audio channel can be turned on or 
off, which means that there are four audio mode options that can be used.
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Full-duplex mode means that you can transmit and receive audio (talk and listen) at the 
same time, without having to use any of the controls. This is just like having a telephone 
conversation. The only controls you may wish to use are the mute buttons to turn off the 
sound, and the sliders, to adjust the input/output volume levels. This mode requires that 
the client PC has a sound card with support for full-duplex audio. If your available 
bandwidth is 0.2 Mbit/s or less, it is recommended that you use Half-duplex mode instead.

Half-duplex mode also transmits and receives audio in both directions, but only in one 
direction at a time. This means that you must select when to receive or transmit audio with 
the help of the push-to-talk button. To speak, press and hold the button (check that the 
microphone is not muted). When finished speaking, release the button. You will now be 
receiving audio from the other end of the connection. 

Note that the push-to-talk button is configured from AMC, see The AXIS Media Control, 
on page 20. It is also possible to configure the push-to-talk button so that it toggles 
between speaking and listening modes. Half-Duplex mode is best if you only have limited 
bandwidth available.

When you select Simplex - AXIS 282A speaker only mode, the speaker connected to the 
AXIS 282A will play audio, but no audio will be transmitted from the AXIS 282A to other 
web clients. This could be used to e.g. provide spoken instructions to a person seen in a 
camera. This mode requires you to use the push-to-talk button.

Simplex - AXIS 282A microphone only mode only transmits audio from the AXIS 282A 
to any web clients. It will not receive audio from any other web clients. This can be used in 
remote monitoring, web attractions etc., to provide live audio, as well as video, of a 
monitored situation.

When using half-duplex, the Send the sound from the active client to all other clients 
option transmits the audio signal from the client that is talking to all the other clients. 

Audio Input

Audio from an external microphone or a line source can be connected to the MIC pin of 
the AXIS 282A. The audio source can be set to Microphone or Line. If you are using a 
microphone, the input sensitivity can be set to High or Low. See Technical Specifications, 
on page 55 for the exact maximum levels.

The Enable microphone power option provides DC power for the external microphone. If 
you use a small electret condenser microphone such as a clip-on mic or a PC microphone, 
this option needs to be enabled. 

To use a high impedance dynamic microphone, DC power should not be enabled. DC power 
will not harm the microphone, but if you are uncertain, try switching it off and on. By 
default value is DC power enabled. To use a professional microphone requiring 48V 
phantom power, you need an external power supply and must use a balanced-unbalanced 
converter (audio transformer) in between. 
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If there are problems with the sound input being too low or high, it is possible to adjust the 
input gain for the microphone attached to the AXIS 282A.

Audio Output

If the sound from the speaker is too low or high it is possible to adjust the output gain for 
the active speaker attached to the AXIS 282A. 

When satisfied with the settings, click Save, or click Reset to revert to the previously saved 
settings.

Advanced Audio Settings

The Advanced Quality Settings allows you to tune the audio input to suit your 
environment.

Enable speech filter improves the sound quality if using a microphone that is placed close 
to the person talking and can also help reduce background noise. The filter cuts the lowest 
and the highest frequencies. The bypass frequency range is approximately 250Hz to 
3700Hz (measured at -10dB cut-off break points).

Enable echo cancellation can reduce the feedback generated when using full duplex. If 
sound distortion is encountered, turning echo cancellation off may improve the sound 
quality.

Noise canceling is a way of reducing the background noise when there is no useful audio 
present. A typical application could be when there a noisy environment and you are only 
interested in hearing the sound when someone is speaking close to a microphone. There are 
two adjustable parameters available to optimize this function:

• Noise canceller threshold value 
• Noise canceller attenuation 
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When the incoming sound is louder than the threshold, it will pass without any changes. 
When lower than the threshold, the incoming sound will be reduced by a certain 
attenuation factor. The threshold value should be set higher than the background noise, 
but lower than the useful audio. 

The noise canceller threshold value can be set to High, Medium High, Medium low and 
Low. A lower threshold will accept most of the audio to pass. Only the weakest 
background noise will be reduced. A higher threshold will make the noise canceller act on 
even stronger background noise. At the maximum level High, there is a risk of reducing 
useful audio as well. 

There is a trade-off between noise canceling and sound quality. In other words, increasing 
the noise canceller attenuation deteriorates sound quality. Adjust the threshold and the 
attenuation to an optimum by listening and changing the levels.
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Live View Config

Layout
These are the tools for deciding 
the layout of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify 
the default page with your own 
colors, images etc. Click the 
Configure button and see the 
following page.

• Own Home Page - Upload and 
use your own custom made 
page as the default web page. 
Click the Configure button and 
see the following page.

The other settings on this page 
concern which other features to 
include, e.g. buttons and links. 
See page 34 for more information.

Customizing the 
default page

The appearance of 
the default AXIS 
282/AXIS 282A Live 
View page can be 
customized to suit 
your own 
requirements, or you 
can upload and use 
your own home 
page. To upload your 
own files, click the 
Upload/Remove 
button and see the 
description below.

Note that the setup address is http://<ip address>/operator/basic.shtml
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Upload Own Web Files

Your own web files, background picture, color etc. must first be uploaded to the AXIS 
282/AXIS 282A in order to be available for selection in the Custom Settings setup dialog. 
Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2. Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

• To use your uploaded file, click the radio button and select the file from the drop-down 
list by Own:

• To use an external file located somewhere other than in the AXIS 282/AXIS 282A, click 
the radio button and enter the URL by External:

Own Home Page

To use a previously uploaded web page as the default page, check the checkbox, select the 
page from the drop-down list and click OK.

User Defined Links 

Enter a descriptive name and enter the URL in 
the provided field. The link will appear on the 
Live View page.

User defined CGI links can be used to issue 
HTTP API requests, e.g. PTZ commands. 
Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM1 Start 
PTZ.

3. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?
camera=1&continuouspantiltmove=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM1 Stop 
PTZ.

User Defined Links
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6. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the PTZ camera

For more information on the Axis HTTP API, see the Support / Developer pages on the Axis 
Web site at http://www.axis.com. See also the section on PTZ, on page 42.

Action Buttons

These buttons can be used to manually trigger and stop an event from the Live View page. 
See Event Servers, on page 37. The snapshot button allows you to take a snapshot of the 
video stream and save it to a computer.

Output Buttons

These buttons are used to control the output on the AXIS 282/AXIS 282A and thus the 
equipment connected to them, for example, to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format in Internet Explorer for Windows

Select the default format to use on the Live View page. Checking the box for Show video 
format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

AMC (AXIS Media Control) Settings

Checking the Show viewer toolbar box displays the AMC toolbar under the video stream. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Default Viewer for Motion JPEG

Select the appropriate radio button to define the method for viewing moving video images, 
depending on your browser and settings.

Please see the online help for more information.
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HTML Examples
You can add live video from your AXIS 282/AXIS 282A to your own web site. The AXIS 
282/AXIS 282A can send Motion-JPEG or MPEG-4 images to up to 20 simultaneous 
connections, although an administrator can restrict this to fewer. This does not affect or 
include the number of multicast viewers.

Enter the Image Type, Image size and other settings to suit your web page and click 
Update.

External Video
You can add links to other Axis network devices available over the network. These sources 
can be displayed on the Live View page, just as if they were video sources connected 
directly to the AXIS 282/AXIS 282A.

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings.

Example of a path to an external video source:

Sequence Mode
The live view page can be configured to rotate through selected internal and/or external 
video sources, in order or randomly. PTZ preset positions can also be included.

Select the desired video sources and enter the time in seconds to display each source (up to 
59 minutes). Click Save.

The Sequence buttons will appear on the Live View page 
to allow the viewer to start and stop the sequence mode.

Please see the online help for more information.

http://192.168.0.125/axis-cgi/mjpeg/video.cgi
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Event Configuration
This section describes how to configure the AXIS 282/AXIS 282A for alarm handling. 
Various actions can be configured to run when certain types of events occur.

A set of parameters describing how and when the Video Server is to perform certain actions

- the circumstances that start an event e.g. at a signal from an external device, such as a door 
switch or a motion sensor

- the circumstances that start an event e.g. at a pre-programmed time

- what occurs when the event runs e.g. video images uploaded to an FTP server, email noti-
fication sent, etc.

Event Servers
Event Servers are used for e.g. receiving uploaded image files and/or notification messages. 
To set up Event server for your AXIS 282/AXIS 282A, go to Setup > Event Configuration 
> Event Servers and enter the required information according to the selected server type.

For details on each setting, please refer to the online help available from each web 
page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test takes approximately 10 seconds). 

Event type

Triggered Event (see page 38)

Scheduled Event (see page 39)

Action

Server type Purpose Information required

FTP Server • receives uploaded images • Descriptive name of your choice
• User Name and Password (to FTP server)
• Upload path, e.g. images/
• Port number
• Use passive mode if there is a firewall between the Video Server 

and FTP server
• Use temporary file if your FTP server doesn’t allow an existing 

file to be overwritten by a new file with the same name.

HTTP Server • receives notification messages
• receives uploaded images

• Descriptive name of your choice
• URL (address)
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server • receives notification messages • Descriptive name of your choice
• User Name and Password (for TCP server)
• Port number
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Event Types
An Event Type is a set of 
parameters describing how 
and when the Video Server 
is to perform certain 
actions.

Example: If somebody walks past 
the connected camera, and an event 
has been configured to act on this, 
the Video Server can e.g. record and 
send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-con-
figured message. Video images can be sent as an attachment with the email.

Triggered Event

A triggered event is activated by e.g:

• a push button connected to an input port on the Video Server
• detected movement in a configured motion detection window
• a lost video signal
• a manually activated action e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event

This example describes how to set the AXIS 282/AXIS 282A to upload images when the 
main door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Select which Video Source the event is to act on, e.g. Video 1 on Main door.

5. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

6. Select the trigger alternative from the Triggered by... drop-down list, 
e.g. an Input port with a connected sensor if the door is opened.

7. Set the When Triggered... parameters, i.e. set what the Video Server should do if 
the main door is opened, e.g. upload images to an FTP server or send an email.

8. Click OK to save the event in the Event Types list.

Please see the online help for descriptions of each available option.
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Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 2 minutes before and after a door was opened. Check the Upload 
images checkbox under Event Types > Add Triggered... > Triggered by... to expand the 
web page with the available options.

Buffer size - Both the AXIS 282 and the AXIS 282A each have a 9 MB buffer.  
The maximum length of time of the pre-/post-buffer depends on the selected image size 
and frame rate.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Note: If the pre- or post-buffer is too large for the AXIS 282/AXIS 282A's internal memory, the frame rate will be 
reduced and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum available) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event

A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event

This example describes how to set the Video Server to send an email notification with 
saved images from a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. Scheduled email.

3. Set the priority (High, Normal or Low).

4. Set the Activation Time parameters (24h clock) when the event should be active, 
e.g. start on Sundays at 13.00 with a duration of 12 hours.

5. Set the When Activated... parameters i.e. set what the Video Server should do at 
the specified time e.g. send uploaded images to an email address.

6. Click OK to save the Event in the Event Types list.
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Please see the online help for descriptions of each available option.

Motion Detection
In the Motion Detection menu, you can configure the video source(s) for motion detection. 
The motion detection feature is used to generate an alarm whenever movement occurs (or 
stops) in the image. The AXIS 282/AXIS 282A can use a maximum of 10 Include/Exclude 
windows.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion 
detection is selected to trigger an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the Video Server.

How to configure Motion Detection

This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Windows radio button.

3. Click New.

4. Enter a descriptive name of your choice under Windows name.

5. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).
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6. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

7. Click Save.

Please use the online help for descriptions of each available option.

High Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects against ordinary 
backgrounds will trigger the motion 
detection

Low Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects against a dark 
background will trigger motion detection

Default values Low Medium to High Medium to High

Examples: 
• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status
Under Event Configuration > Port Status, there is a list that shows the status for the 
connected inputs and outputs of the AXIS 282/AXIS 282A. This is for the benefit of an 
operator, who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit, as long as the button is 
not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and repeat steps 1-8 above.

Parameter  Size History Sensitivity
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Pan Tilt Zoom 

Installing PTZ Devices
The AXIS 282/AXIS 282A supports several PTZ devices. Please see www.axis.com for a 
complete list of supported devices, and to obtain the correct driver. Follow the instructions 
below to install a PTZ device:

1. Using an appropriate cable, connect the device to your selected port (RS-232 or 
RS-485). This configurable port is available via the 34 I/O pins. See pages 58 and 
59 for more information.

2. In the setup tools, go to Setup > System Options > Ports & Devices and then 
select the port (RS-232/RS-485) to configure. 

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. Click Upload to install a PTZ driver. 
(PTZ drivers are available from the Axis Web site at www.axis.com)

5. Click Port Options... to modify the port settings. The default values correspond to 
the values specified by the PTZ driver.

6. From System Options > Ports & Devices, select the port configured for PTZ and 
then select the video source to use with the device.

7. If required, click the Advanced Options button to make further settings and see 
the online help.
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Note: Advanced users and application developers can also use the Axis Application Programming Interface and 
HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to 
the Axis Website at www.axis.com for further information.

PTZ Configuration
Once PTZ has been installed for the AXIS 282/AXIS 282A, PTZ Configuration now appears 
in the menu to the left along with the following submenus.

Preset Positions 
A preset position is a pre-defined camera view than can be used to quickly move the 
camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera 
to the required position. When satisfied with the camera's position, enter a descriptive 
name. The camera position, iris and focus settings are then saved as a preset position.

The position can be assumed at any time, by selecting the preset's name from the Preset 
positions drop-down list. Preset positions can be selected in Live View, from events and in 
Sequence mode.

One position can be set as the Home position, which is readily accessible by clicking in the 
box beside Use current position as Home. The position's name will then have (H) added, 
e.g. Office Entrance (H).



 44 AXIS 282/AXIS 282A - Pan Tilt Zoom
PTZ Controls
If the AXIS 282/AXIS 282A has been appropriately configured, the Live View page will 
display the controls available for the installed Pan Tilt Zoom (PTZ) device. The 
administrator can enable/disable the controls for specified users.

Video sources

Preset positions

Tilt bar (relative)

The exact controls shown depends on the make and model of PTZ device. There may be 
e.g. Focus and Iris bars available as well, but the most common controls are;

• the Pan bar - moves the camera to the right and left 
• the Tilt bar - tips the camera up and down
• the Zoom bar - zooms the view in and out. Note that this is only available if the 

camera is fitted with a zoom lens.
• the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the 
camera to a new position. The type of movement and the location of this new position 
depends on the type of PTZ driver. 

When controlling the camera using a relative PTZ driver (see the bars in the illustration 
above) the new position will be relative to the previous position, e.g. left of, below, above, 
etc. Clicking the bar further from the center results in a larger movement. 
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In contrast, when using an absolute driver, each 
position on the bar (see right) represents a defined 
position in the device’s range of movement, with the center of the bar representing the 
point midway between the two extremes of movement.

Clicking a position directly on the bar moves the camera directly to the new position in 
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, 
incremental change. 

Using CGI links to control PTZ devices

User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. 
PTZ commands. These links are configured in the Live View Layout settings, see page 34.

PTZ Control Modes

The PTZ device can also be controlled using click-in-image movement, which has two 
different types of navigation; Center and Joystick.

Center mode means that when clicking in the image, the camera view will center on the 
absolute position that was clicked.

Joystick mode moves the camera in the direction of the mouse pointer. By clicking and 
holding the mouse button down in the image, the PTZ device moves the camera in that 
direction, relative to the center of the image. The further from the center the image is 
clicked, the greater the movement. The camera stops moving when the button is released. 

Control Panel

The Focus and Iris (image brightness) can be adjusted manually by using the control bars, 
or they can be set for automatic adjustment, by clicking the Auto Iris and Auto Focus 
buttons.

To access the Auto Iris and Auto Focus buttons, click on the Ctrl 
Panel button. the menu to the right will then appear in the upper left 
hand corner of the screen.

There are also driver specific shortcuts that can appear in the Control 
Panel. In the screen to the right, a driver has been installed that 
brings up the Wiper shortcut button, which allows the user to 
configure and use a windshield wiping action with the AXIS 
282/AXIS 282A .
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Preset Positions

Also available with many PTZ devices are Preset positions. These presets are selected from 
the drop-down Source list on the Live View page and will move and/or zoom the camera 
to a pre-defined position, i.e. to cover an area of particular interest. Events can also be 
configured to go to preset positions when triggered. For information on setting up preset 
positions, please see Preset Positions, on page 43 and the online help.

Guard Tour
A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined 
order or randomly, and for configurable time periods. Unlike the Sequence Mode, which is 
a viewing application under Live View Config (see Live View Config, on page 33), the 
guard tour sequence will keep running after the user has logged off or closed the Web 
browser.

Advanced
Device Settings - The device settings window is for driver specific settings, so the 
appearance of this window can vary depending on the driver installed. Options that can be 
configured include: Driver Specific Settings for Video Source 1, Mechanical Limits for 
Moving Video Source 1, Light Control for Video Source 1, and Extended Driver Specific 
Settings for Video Source 1.

Ctrl Panel - The Panel View Settings contains tools for creating and saving short 
command buttons are located under Ctrl Panel. These buttons provide direct access to 
various built-in auxiliary commands provided by the PTZ driver and are displayed in the 
PTZ Panel.

Limits - Define the pan, tilt, zoom and focus limits for the AXIS 282/AXIS 282A. 
Movements to the left and right, up and down can be restricted to narrow the area under 
surveillance. The near focus limit can be set to avoid focusing on objects too close to the 
camera.
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OSD Menu - If the PTZ unit supports an internal configuration menu, this can be accessed 
using the On-Screen Display (OSD). Configure the analog camera by opening and 
navigating through its internal menu in this display.

PTZ Control Queue 

Use the PTZ Control Queue window to enable and disable PTZ queueing. This window 
allows you to set up a queue for viewers wanting to access the AXIS 282/AXIS 282A, and 
limits the number of viewers and the length of time each viewer can access and control the 
video stream. For more information on how to set up the control queue, please see the 
online help.

Note also that a viewer who belongs to a group (see  Users, on page 49) that has a higher 
PTZ priority can go in front of other users in the queue and take control of the AXIS 
282/AXIS 282A. 

The order of priority for taking control of the queue is listed below:
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1. Administrators - An administrator may take the PTZ control regardless of who is 
currently first in queue. The administrator will be removed from queue 60 
seconds after the their last PTZ control command.

2. Event - You can set up the AXIS 282/AXIS 282A to take control of the queue and 
move to a specific position for 20 seconds when triggered by an alarm. The event 
will immediately be place first in queue except when an administrator is in 
control. For more information see How to set up a triggered event, on page 38.

3. Operator - Same as administrator with lower priority.

4. Guard Tour - Guard tour has control of PTZ for an indefinite period of time. It 
may be overridden by, Operator, Event or administrator. Guard Tour will resume 
when higher priority groups leaves the queue. For more information see Guard 
Tour, on page 46.

5. Viewer - Multiple viewers will need to wait for their turn. The viewer has 60 
seconds to control PTZ until control is passed to the next viewer in queue. 

Note: In order to be able to identify different users in the viewer group, cookies need to be enabled on the client.
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System Options

Security
User access control is enabled by default, when the administrator sets the root password on 
first access. New users are authorized with user names and passwords, or the administrator 
can choose to allow anonymous viewer login to the Live View page, as described below:

Users 

User list displays the authorized users and access levels:

Provides the lowest level of access, which only allows the user access to the Live View page
An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.
An administrator has unrestricted access to the Setup Tools and can determine the registration of 
all other users. 

User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View page.
• Anonymous PTZ control login - allows any viewer access to the Pan Tilt Zoom con-

trollers on the Live View page (if Pan/Tilt/Zoom is available).

IP Address Filtering

Checking the Enable IP address filtering box enables the IP address filtering function. Up 
to 256 IP address entries may be specified (a single entry can contain multiple IP 
addresses). Click the Add button to add new filtered addresses.

When the IP address filter is enabled, addresses added to the list are set as allowed or 
denied addresses. All other IP addresses not in this list will then be allowed or denied 
access accordingly, i.e. if the addresses in the list are allowed, then all others are denied 
access, and vice versa. See also the online help for more information.

Note that users from IP addresses that will be allowed must also be registered with the 
appropriate access rights (User, Operator or Administrator). This is done from Setup > 
System Options > Security > Users. 

Referrals - to prevent unauthorized sources from including the video stream from the 
AXIS 282/AXIS 282A into external Web pages, check the Referrals box and enter the IP 
address or Host name of the computer that hosts the Web pages with the included video 
stream. Multiple IP addresses/host names can be defined and are separated by semicolons(;)

Viewer

Operator

Administrator
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Notes: •If the referrals feature is enabled and you wish to also allow normal access to the Live View 
page, the product's own IP address or host name must be added to the list of allowed referrers.

•Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP 
address filtering must be enabled.

•Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP 
addresses.

HTTPS

For greater security, the AXIS 282/AXIS 282A can be configured to use HTTPS (Hypertext 
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would 
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 282/AXIS 282A, a Certificate 
must be created using one of these methods:

• A self-signed certificate can be created in the Video Server, but this does not guarantee 
the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages 
security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy 
and send to a CA for signing. When the signed certificate is returned, click Install 
signed certificate... to install the certificate in the AXIS 282/AXIS 282A.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please see the online help
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Date & Time
Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in overlay images.

New Server Time - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your computer. 
• Synchronize with NTP Server - the Video Server will obtain the time from an NTP 

server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.
Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File 
Naming & Date/Time Formats in the online help for information on how to create 
your own file formats.

Network - Basic TCP/IP Settings

IP Address Configuration

The IP address of the Video Server can be set automatically via DHCP, or a fixed IP address 
can be set manually. DHCP is enabled by default. To use a fixed IP address, you must also 
enter the correct subnet mask and default router.

Notes: •DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via 
DHCP may lead to the situation where the IP address changes and you lose contact. Configure 
the options for notification of IP address change (under Services) to receive notification from 
the Video Server when the IP address changes.

•Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 282/AXIS 
282A by host name which is always the same, regardless of the IP address.

Services

Options for notification of IP address change - if the IP address for the Video Server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.
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AXIS Internet Dynamic DNS Service - If the AXIS 282/AXIS 282A Video Server has been 
registered with the Axis Internet Dynamic DNS service and the IP address for the product 
changes, the service is updated to reflect the change. Check the box to enable/disable 
automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your 
product can at any time be removed. To do this click Settings... and follow the 
instructions. 

For more information, please refer to the online help.

Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
282/AXIS 282A. Multiple domains can be separated by semicolons (;). The host name is 
always the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in 
the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is 
the Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP

Obtain NTP server address via DHCP - use a DHCP server to auotmatically find an NTP 
server to synchronize clock of the AXIS 282/AXIS 282A with the other devices on the 
network

Use the following NTP server address - use the host name or IP address of a specific NTP 
server for time synchronization.

Host Name Configuration

The AXIS 282/AXIS 282A can be accessed using a host name, instead of an IP address. The 
host name is usually the same as the assigned DNS Name.

For more information, please see the online help
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Link-Local Address

This is enabled by default and assigns the AXIS 282/AXIS 282A an additional IP address 
for use with UPnP™. The AXIS 282/AXIS 282A can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other. 

HTTP 

The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

HTTPS 

The default HTTP port number (443) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554.

Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
Video Server is allowed to use on your network. This is a useful function when connecting 
your Video Server to busy or heavily loaded networks. The default setting is Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help

SOCKS 
SOCKS is a networking proxy protocol. The AXIS 282/AXIS 282A can be configured to use 
a SOCKS server to reach networks on the other side of a firewall/proxy server. This 
functionality is useful if the Video Server is located on a local network behind a firewall, 
but notifications, uploads, alarms, etc., need to be sent to a destination outside the local 
network (e.g. to the Internet).
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SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the 
fields provided, to enable event and error email messages from the Video Server to 
predefined addresses, via SMTP. 

If the mail server requires SMTP authentication, check the box for Use authentication to 
log in to this server and enter the user name and password used for logging in. Several 
different methods of authentication are available. See the online help for more 
information. 

SNMP
The Simple Network Management Protocol (SNMP) allows the remote management of 
network devices. Select the version of SNMP to use, depending on the level of security 
required. Select the version of SNMP to use, by checking the appropriate box. The three 
levels of security are:

• SNMP V1 - includes no security
• SNMP V2c - uses very simple security, e.g. community name as password
• SNMP V3 - provides encryption and secure passwords. Use with HTTPS. 
If using V1 and V2c, enter the community name for read-only access to all supported 
SNMP objects (except the root password and other objects that require write access). 
Default value = public. You can also specify the community name for read/write access to 
all supported SNMP objects (except read-only objects). Default value = pass. 

If using HTTPS enter the password if it has not already been set. To set the password again, 
the AXIS 282/AXIS 282A must be reset to the factory default settings.

UPnP™
The Video Server includes support for UPnP™ in Windows ME and Windows XP. UPnP™ is 
enabled by default.

Note: UPnP™ must be installed on your workstation if running Windows XP. To do this, open the Control Panel 
from the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and 
open the Networking Services section. Click Details and then select UPnP™ as the service to add.

RTP/MPEG-4
These settings are the IP address, port numbers, and Time-To-Live values to use for the 
media stream(s) in the MPEG-4 format. Only certain IP addresses and port numbers should 
be used for these streams. For more information, please see the online help.
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Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in Unit Connectors, on page 58.

RS-232/RS-485 - The COM port on the AXIS 282/AXIS 282A, which can be configured as 
RS-232 or RS-485, supports several operational modes listed on this page. For more 
information, please see the online help.

Maintenance
• Restart - The unit is restarted without changing any of the settings. Use this method if 

the unit is not behaving as expected.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that will not be reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the Video Server's settings to the factory default values (including the IP address)

Upgrade Server - See Upgrading the Firmware, on page 61.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it is then possible to return to a previous configuration if settings are 
changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for multi-configurations or for firmware upgrades.
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Support
The Support Overview page provides valuable information on troubleshooting and 
contact information, should you require technical assistance.

The System Overview gives a quick look over the status of the camera.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

Information - The Log report and the Parameter List also provide valuable information 
for troubleshooting and when contacting Axis’ support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis Video 
Server configuration. All parameters can be set and modified from this page, 
including the audio encoding format. Help is available from the standard help pages.
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Resetting to the Factory Default Settings
To reset the AXIS 282/AXIS 282A to the original default settings, go to the System 
Options > Maintenance web page (described in Maintenance, on page 55) or use the 
control button on the AXIS 282/AXIS 282A, as described below:

Using the Control Button

Follow the instructions below to reset the AXIS 282/AXIS 282A to the factory default 
settings using the Control Button.

1. Switch off the AXIS 282/AXIS 
282A by disconnecting power.

2. Press and hold the Control 
button while reconnecting the 
power.

3. Keep the Control button 
pressed until the Status 
Indicator displays yellow (this 
may take up to 15 seconds).

4. Release the Control button.

5. When the Status Indicator changes to Green (may take up to 1 minute), the 
process is complete and the AXIS 282/AXIS 282A has been reset.

6. Re-install the AXIS 282/AXIS 282A, as described in Installation, on page 10.

Control buttonStatus Indicator
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Unit Connectors
The following connectors are described in this section:

•  The Terminal I/O Connector, on page 58
•  The 34-Pin Header, on page 59

The Terminal I/O Connector
The AXIS 282/AXIS 282A provides one 4-pin terminal I/O connector.

1 Power in/out (8 - 20V)

2 GND

3 I/O In

4 I/O Out

If the AXIS 282/AXIS 282A has been configured to have power going in through the 34 
I/O pins see Schematic Diagram - 34 I/O Pins, on page 60, power can can be configured to 
go out through pin 1of the Terminal I/O Connector.

Schematic Diagram - Terminal I/O Connector

+3.3V

-

+ Pin 1 Power in/out (8 - 20V)

Pin 2 GND

Pin 3 I/O In

Pin 4 I/O Out

Note: The gray box shows components
           located on the Axis 282/282A.

Pin Function

Pin 2Pin 1 Pin 3 Pin 4
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The 34-Pin Header
This section describes the pinout and interface support provided by the 34-pin I/O terminal 
connector:

1 Network LED green 18 Mic/Line in GND

2 Network LED red 19

3 Status LED green 20 Line out GND

4 Status LED red 21 RS-485 B

5 Flash LED 22 RS-485 A

6 Power LED 23 Serial port RTS (RS-232)

7 Control button 24 Serial port CTS (RS-232)

8 I/O IN 25 Serial port TXD (RS-232)

9 I/O OUT 26 Serial port RXD (RS-232)

10 I/O GND 27 Serial port GND

11 Y/C Video in (Y) 28 Power GND

12 Y/C GND 29 Power GND

13 Y/C Video in (C) 30 Power I/O

14 Y/C GND 31 Power GND

15 Composite video in 32 Power IN

16 Composite Video Source GND 33 Power IN

17 34 Power IN

Pin Function Pin Function

•AXIS 282: Not used
•AXIS 282A Line out (Audio)

•AXIS 282: Not used
•AXIS 282A MIC/Line in

Pin
33

Pin
34

Pin
01

Pin
02
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Schematic Diagram - 34 I/O Pins

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

GND

RS 232 Device

Switch Mode
Power Supply

Power I/O

Power 8 - 20V

RS 485
External Device

Amp

Microphone

Composite
Video Source

Y/C
Video Source

+3.3V

+3.3V

+

-

GND

Note: The gray box shows components
           located on the Axis 282/282A.
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Troubleshooting

Checking the Firmware
Firmware is software that determines the functionality of the AXIS 282/AXIS 282A. One of 
your first actions when troubleshooting a problem should be to check the currently 
installed version. The latest version may contain a correction that fixes your particular 
problem. The current firmware version in your AXIS 282/AXIS 282A can be seen under 
Setup > Basic Configuration.

Upgrading the Firmware
When you download firmware from the Axis Web site, your Axis product will receive the 
latest available functionality. Always read the upgrade instructions and release notes 
available with each new release, before updating the firmware.

New firmware can be downloaded to the AXIS 282/AXIS 282A over the network.

Note: Pre-configured and customized settings will be retained for use when the new firmware is running (pro-
vided the features are available in the new firmware) although this is not guaranteed by Axis Communica-
tions. 

1. Save the firmware file to your computer. The latest version of the AXIS 282/AXIS 
282A firmware is available free of charge from the Axis Web site at 
www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the Video Server’s Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: •Always read the upgrade instructions available with each new release, before updating the firm-
ware.

•After starting the process, you should always wait at least 20 minutes before restarting the AXIS 
282/AXIS 282A, even if you suspect the procedure has failed.

•Your dealer reserves the right to charge for any repair attributable to faulty updating by the 
user.
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Emergency Recovery Procedure
If power or the network connection to the AXIS 282/AXIS 282A is lost during the upgrade, 
the process will fail and the unit will become unresponsive. A flashing red Status LED 
indicates a failed upgrade. To recover the unit, follow the steps below. The serial number is 
located on the memory capsules on top of the AXIS 282/282A..

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of AXIS 282/AXIS 282A> <Serial number> temp 
ping -s 408 <IP address of AXIS 282/AXIS 282A> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of AXIS 282/AXIS 282A> <Serial number> 
ping -l 408 -t <IP address of AXIS 282/AXIS 282A> 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 282/AXIS 282A’s IP address. In the page that 
appears, use the Browse button to select the upgrade file to use, e.g. axis282qa.bin or 
axis282sa.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power and Status LEDs and flashing green or amber on the 
Network LED. 

5. Reinstall the AXIS 282/AXIS 282A. 

If the emergency recovery procedure does not get the AXIS 282/AXIS 282A up and 
running again, please contact Axis support at www.axis.com/techsup/ 

Support
If you contact Axis support, please help us help you resolve your problems expediently by 
providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP/Ping - the IP address 
must be set within two minutes 
after power has been applied to 
the Video Server

Restart the server and try again. Ensure also the ping length is set to 408. See or  ARP and Ping 
in Windows on page 12, or  ARP and Ping in UNIX/Linux on page 13.

The Video Server is located on a 
different subnet.

If the IP address intended for the AXIS 282/AXIS 282A and the IP address of your computer are 
located on different subnets, you will not be able to set the IP address. Contact your network 
administrator for an IP address on the same subnet as the computer you are performing the 
installation from.

The IP address is being used by 
another device

Disconnect power from the AXIS 282/AXIS 282A.  
Run the Ping command (in a Command/DOS window, type ping <IP address of unit> 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
Video Server. In this case, check all cabling and reinstall the unit.

The AXIS 282/AXIS 282A cannot be accessed from a Web browser
Cannot log in If the AXIS 282/AXIS 282A has been configured to use HTTPS, check that the protocol in the 

URL used to access the unit is correct. You may need to type this in manually (i.e. http or https) 
in the browser’s address field.

The IP address has been changed 
by DHCP

1) Move the AXIS 282/AXIS 282A to an isolated network or to one with no DHCP or BOOTP 
server. Set the IP address again, using the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The Video Server can be configured to use a SOCKS server to reach networks on the other side 

of a firewall/proxy server

Your AXIS 282/AXIS 282A is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily 
loaded

Use a script on your web server to relay images from the AXIS 282/AXIS 282A to the Internet. 

The Power indicator is not constantly lit
Faulty power supply Verify that you are using the correct power supply.

The Status and network indicators are flashing red
Hardware failure Contact your Axis dealer.

The Status indicator is flashing red and the server is inaccessible
A firmware upgrade has been 
interrupted or the firmware has 
been damaged in some other 
way.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping, see page 10. Then, using a browser, access the unit and download the latest firmware 
to the product, see Upgrading the Firmware, on page 61.
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No images displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure your AXIS 282/AXIS 282A to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for more 
information.

Video Image Problems
Black borders around the video 
image

Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring e.g. pre-buffers, motion detection, high resolution images, high frame rates, etc., 
will reduce the performance of the Video Server. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, multiple users accessing the 
unit, low performance clients, use of features such as Motion Detection, Event handling, Image 
rotation.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
AXIS 282/AXIS 282A are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your router supports multicasting, or if the router settings between the client and the 
server need to be configured. The TTL (Time To Live) value may need to be increased.

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to enable 
Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usually be 
downloaded from the manufacturer's web site. 

Color saturation is different in 
MPEG-4 and Motion JPEG.

Modify the settings for your graphics adapter. Please see the adapter's documentation for more 
information.

No audio 
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For additional assistance, please contact your reseller or check the product’s support pages on 
the Axis Website at www.axis.com/techsup

 Incorrect setup. Check that the sound card in the PC and the connections to the speaker and microphone are 
working. Ensure that the mute button is not pressed and the volume settings are correct. 
Ensure that full-duplex is selected if you want to have two way audio communication. 

Post Content Length in proxy 
server.

The Post Content Length set in the proxy server is too low. Set the value of the Post Content 
Length in your proxy server to 1MB or more. You may need to contact your system administra-
tor to do this.

Full duplex not supported. Sound card does not support full-duplex. For information on how to check if your sound card 
supports full-duplex, please visit http://support.microsoft.com

Firewall or router settings. AXIS 282/AXIS 282A works locally, but not externally. Check the Internet firewall settings with 
your system administrator or reconfigure the default router settings.

DC power not enabled for micro-
phone.

If the microphone has a built-in amplifier then the DC power must be enabled on the Audio 
Settings page.

Audio volume too low/high
Volume settings incorrect. The volume of the microphone or speaker connected to the AXIS 282/AXIS 282A is either too 

high or too low. Change the volume for the speaker or microphone in the Live View page. 

Input and output gain set incor-
rectly.

Change the input gain for the microphone and the output gain for the speaker to adjust the 
audio levels on the Audio Settings page.

Poor audio quality
Too many users. Too many users/clients listening to audio from the AXIS 282/AXIS 282A may adversely affect 

the sound quality. 

User too close to microphone. Enable the speech filter in Audio > Advanced Settings.
Feedback from speaker. Enable the echo cancellation filter in Audio > Advanced Settings.
Background noise. Adjust the noise cancellation threshold and attenuation to reduce background noise levels in 

Audio > Advanced Settings.
CPU overloaded. Reduce the number of listeners and viewers and decrease the image resolution and compres-

sion.
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Technical Specifications

Item Specification

Models • AXIS AXIS 282: 1-channel bare board video server
• AXIS AXIS 282A: 1-channel bare board video server with two-way audio

Video compression • Motion-JPEG 
• MPEG-4 Part2 (ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 4CIF, 2CIF Expanded, 2CIF, CIF, QCIF
• Maximum 704x480 (NTSC) 768x576 (PAL)
• Minimum 160x120 (NTSC) 176x144 (PAL)

Frame rates
(NTSC/PAL)

• Motion JPEG: Up to 30/25 fps at 4CIF
• MPEG-4: Up to 30/25 fps at 2CIF
• MPEG-4: Up to 20/17 fps at 4CIF

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and total bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 11 (Motion JPEG), 23 (MPEG-4)
• Rotation: 90o, 180o, 270o

• Aspect ratio correction
• Color and black/white
• Overlay capabilities: time, date, text, image or privacy mask
• Deinterlacing filiter

Audio features
AXIS 282A only

• G.711 PCM 64kbit/s, G.726 ADPCM 32 or 24 kbit/s, full duplex, half duplex, simplex 
or audio off

Security • Multiple user levels with password protection
• IP address filtering
• HTTPS encryption

Alarm and event 
management

• Events triggered by built-in motion detection, external inputs or according to a 
schedule 

• Image upload over FTP, email and HTTP 
• Notification  over  TCP,  email,  HTTP  and  external  outputs 
• Pre-  and  post  alarm  buffer  of  9  MB  (approx.  4  min of  CIF  resolution  video  at  

4  frames  per  second)

Pan/Tilt/Zoom • A wide range of analog PTZ dome cameras are supported, free drivers available at 
www.axis.com

• 20 presets, Guard tour, PTZ  control  queuefor all supported PTZ units available from 
www.axis.com
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Connectors • One 34-pin I/O header  
- 1 analog composite or Y/C video input (NTSC/PAL autosensing )  
- RS-485 or RS-232 port  
- 1 alarm input, 1 alarm output 
- Power connection (input and output)  
- LED outputs  
- Audio input (282A): Microphone (54 mVpp) or Line in (8.0 Vpp), mono  
- Audio output (282A): Line out (2.6 Vpp), mono

• Terminal block:  
- 1 alarm input, 1 alarm output  
- Alternative power connection 
- Ethernet 10BaseT/100BaseTX, RJ-45connector

Processors and memory • CPU: ETRAX-100 LX 32-bit
• Video processing and compression: ARTPEC-2 chip
• RAM AXIS 282 - 32MB
• RAM AXIS 282A - 32MB
• Flash memory - 8 MB

Power • Via pin 3 of the Terminal Block: 8 - 20V DC, max 8W 
• Via pins 32 - 34 of the 34-pin header: 8 -20V DC, max 8W

Operating conditions • Temperature: 5oC (41oF) to 50oC (122oF)
• Humidity: 20-80% RH (non-condensing)

Installation, management 
and maintenance

User’s manual and installation tool available at www.axis.comWeb-based 
configurationConfiguration backup and restoreFirmware upgrades over HTTP or FTP, 
firmware available at www.axis.com 

Video access from Web 
browser

• Camera live view
• Sequence tour capability for up to 20 PTZ presets or other Axis video sources
• Customizable HTML pages

Minimum web browsing 
requirements

• Pentium III 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows: XP, 2000, NT 4.0, ME or 98*
• DirectX 9.0 or later
• Internet Explorer 5.x or later. For other operating systems and browsers, see 

www.axis.com/techsup

*Motion JPEG only

System integration 
support

• Powerful API for software integration available at www.axis.com, including HTTP 
API, AXIS Media Control SDK

• Event trigger data in video stream
• Embedded scripting and access to serial port peripherals over HTTP/TCP
• Watchdog secures continuous operation, and can be monitored by other systems via 

event notification
• Embedded operating system: Linux 2.4

Item Specification
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Supported protocols HTTP, HTTPS, SSL/TLS*, TCP, SNMPv1/v2cv/v3 (MIB-II), RTSP, RTP, UDP, IGMP, RTCP, 
SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS. More information on protocol 
usage available at www.axis.com

*This product includes software developed by the Open SSL Project for use in the Open 
SSL Toolkit.

Applications
(not included)

• API AXIS Camera Station - Surveillance application for viewing, recording and 
archiving up to 25 cameras

• AXIS Camera Management – Efficient installation and management tool for Axis 
network video products

• AXIS Camera Explorer – Basic software for viewing and manual recording
• See www.axis.com/partner/adp_partners.htm for more software applications via 

partners

Included Accessories • Pentium MPEG-4 licenses (1 encoder, 1 decoder)
• MPEG-4 decoder (Windows)

Accessories
(not included)

• AXIS 292 Network Video Decoder
• AXIS MPEG-4 Decoder 10 user license pack

Approvals • AXIS AXIS 282/AXIS 282A is delivered as a component for the sole purpose of being 
integrated into a product or system. The foregoing implies an obligation on behalf of 
the integrator to obtain any approvals from authorities or governmental bodies that 
may be required for the lawful use of the finished product or system, which includes 
the AXIS 282/AXIS 282A as a component.Resale and use of the AXIS 282/AXIS 282A 
on a stand-alone basis is not allowed.

Dimensions • HxWxD = 19 x 79 x 82mm (3/4” x 3 1/8” x 3 1/4”) 
• Weight: 60g (2 1/8oz)

Item Specification
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General performance considerations
When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC lowers perceived performance. Frame 

rate affected.
• Access by large number of audio clients using full-duplex mode. Bandwidth 

affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
282/AXIS 282A provides a tool that can be used to display these values directly in the 
video image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps) 
bandwidth in Kbps) to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 
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Important!
•The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

•For Motion JPEG, these values will only be accurate as long as no frame rate limit has been 
specified.

Frame rates - Motion JPEG 
The following test results show the frame rates in frames/second (fps) for Motion JPEG 
streams from the AXIS 282/AXIS 282A, using a compression level of 50%. Note that these 
values are guidelines only - actual values may vary.

Frame rates - MPEG-4
The following test results show the frame rates in frames/second (fps) for MPEG-4 streams 
from the AXIS 282/AXIS 282A. Note that these values are guidelines only - actual values 
may vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.

fps (PAL/NTSC) 
1 channel

4CIF 25/30
2CIF expanded 25/30

2CIF 25/30
CIF 25/30

QCIF 25/30

fps (PAL/NTSC) 
1 channel

4CIF 17/21
2CIF expanded 17/21

2CIF 25/30
CIF 25/30

QCIF 25/30
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Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the analog cameras connected to the Video Server
• the audio settings

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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Glossary 
Active Speaker - a speaker with a built-in power 
amplifier.

ActiveX - A control (or set of rules) used by a browser. 
ActiveX controls are often downloaded and installed 
automatically as required.

AMC - AXIS Media Control. The control required for 
viewing video images in Internet Explorer. Installs 
automatically on first use.

API - Application Programming Interface. The Axis API 
can be used for integrating Axis products into other 
applications.

ARP - Address Resolution Protocol. Used to associate an 
IP address to a hardware MAC address. A request is 
broadcast on the local network to find out what the MAC 
address is for the IP address.

ARTPEC - Axis Real Time Picture Encoder - used for 
image compression.

BOOTP - A protocol that can automatically configure a 
network device (give it an IP address). 

CGI - Common Gateway Interface. A set of rules (or a 
program) that allows a Web Server to communicate with 
other programs.

Client/Server - Describes the network relationship 
between two computer programs, in which one, the client, 
makes a service request from another - the server.

DC-Iris - This special type of iris is electrically controlled 
by the Axis camera, to automatically regulate the amount 
of light allowed to enter.

dB (Decibels) - A unit to measure sound level changes. A 
3dB change is the smallest level change we can hear. A 
3dB change is actually twice or half the audio power 
level. A gain of 0dB will leave the signal level unchanged.

De-interlacing - De-interlacing is the process taking a 
stream of interlaced frames and converting it to a stream 
of progressive frames.

DSL - Digital Subscriber Line. A means of transferring 
data via standard phone lines.

Ethernet - A widely used networking standard.

ETRAX - Axis' own microprocessor.

Firewall - A virtual barrier between a LAN (Local Area 
Network) and other networks, e.g. the Internet.

FTP - File Transfer Protocol. Used for the simple transfer 
of files to and from an FTP-server.

Full-duplex - Transmission of data, e.g. audio, in two 
directions simultaneously. 

G.711 - G.711 is the international standard for encoding 
telephone audio on 64 kbps channel. It is a pulse code 

modulation (PCM) scheme operating at 8 kHz sample rate. 

G.726 - Frequently used speech-compression algorithm in 
telecommunications due to its high perceived speech 
quality and low resource requirements. 

Half-duplex- A half-duplex link communicates in one 
direction at a time only, much like a walkie-talkie. Two 
way communication is possible, but not simultaneously. 

HTTP - Hypertext Transfer Protocol. The set of rules for 
exchanging files (text, images, sound, video, and other 
files) on the World Wide Web.

HTTP-S (HTTPS)- An extension to the HTTP protocol to 
support sending data securely over the World Wide Web. 

Intranet - A private network limited to an organization or 
corporation. Usually closed to external traffic.

IP - Internet Protocol. See TCP/IP.

IP address - A unique number used by a computer on the 
network to allow it to be identified and found.

ISMA - Internet Streaming Media Alliance.

JPEG - A standard image format, used widely for 
photographs. Also known as JPG.

LAN - A local area network (LAN) is a group of computers 
and associated devices that typically share common 
resources within a limited geographical area.

Linux - A popular operating system that is “open source” 
and practically free of charge.

Lux - A standard unit for light measurement.

Mbit/s - Megabits per second. A unit for measuring 
speeds in networks. A LAN might run at 10 or 100 Mbit/s.

MPEG-4 - A video compression standard that makes good 
use of bandwidth, and which can provide DVD-quality 
video streams at less than 1 Mbit/s. 

Multicast - A bandwidth-conserving technology that 
reduces bandwidth usage by simultaneously delivering a 
single stream of information to multiple network 
recipients. 

PEM - Privacy Enhanced Mail. An early standard for 
securing electronic mail. The PEM-format is often used 
for representing an HTTPS certificate or certificate 
request.

Ping - A small utility used for sending data packets to 
network resources to check that they are working and that 
the network is intact.

Pre/post alarm image - The images from immediately 
before and after an alarm.

Protocol - A special set of rules governing how two 
entities will communicate. Protocols are found at many 
levels of communication, and there are hardware 
protocols and software protocols.

Router - A device that determines the next network point 
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to which a packet should be forwarded on its way to its 
final destination. A router is often included as part of a 
network switch (see below).

RTP- Real-Time Transfer Protocol. A transfer protocol 
designed for the delivery of live content, e.g. MPEG-4.

Simplex - In simplex operation, a network cable or 
communications channel can only send information in 
one direction; it's a “one-way street”. 

SMTP - Simple Mail Transfer Protocol is the protocol used 
to send e-mail across the Internet. SMTP authentication is 
a way of allowing people outside of a domain to use an 
SMTP server when sending e-mail.

SNMP - Simple Network Management Protocol. An 
application layer protocol that facilitates the exchange of 
management information between network devices. It is 
part of the Transmission Control Protocol/Internet 
Protocol (TCP/IP) protocol suite.

Subnet Mask - An IP address consists of two 
components: the network address and the host address. 
“Subnetting’ enables a network administrator to further 
divide the host part of the address into two or more 
subnets. The subnet mask identifies the subnet to which 
an IP address belongs. 

Switch - Whilst a simple hub transmits all data to all 
devices connected to it, a switch only transmits the data 
to the device it is specifically intended for. 

TCP/IP - Transmission Control Protocol/Internet Protocol. 
A suite of network protocols that determine how data is 
transmitted. TCP/IP is used on many networks, including 
the Internet. TCP keeps track of the individual packets of 
information and IP contains the rules for how the packets 
are actually sent and received. 

UDP - The User Datagram Protocol is a communications 
protocol that offers a limited amount of service when 
messages are exchanged between computers in a network 
that uses the Internet Protocol (IP). UDP is an alternative 
to the Transmission Control Protocol (TCP) and, together 
with IP, is also known as UDP/IP.

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. 

URL - Uniform Resource Locator. An “address" on the 
network.

Varifocal - A varifocal lens provides a wide range of 
focal lengths, as opposed to a lens with a fixed focal 
length, which only provides one.

WAN - Wide-Area-Network. Similar to a LAN, but on a 
larger geographical scale.

Web server - A program on a computer that delivers the 
resources (usually web pages) requested by the web user 
(the client).
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Index

A
Action 37
Action buttons 16, 35
Active/Inactive 16, 35
Administrators 23, 49
Advanced TCP/IP settings 52
Alarm 37, 40
AMC 20
Anonymous viewers 49
ARP and Ping 12
Audio input 30
Audio mode 29
Audio output 31
Audio transmission 21
AXIS Internet Dynamic DNS Service 14, 52
AXIS IP Utility 10
AXIS Media Control 30

B
Backup 55
Bandwidth 18, 71
Basic TCP/IP settings 51
Buffers 39

C
CGI links 34, 45
Click-in-image 45
Constant bit rate 18
Control button 9, 57
Customize 33

D
Date & Time 51
Default viewer 35
DIP switch 9
DNS configuration 52

E
Email server 54
Emergency recovery 62

Event servers 37
Event types 37
External video 36
External video sources 16

F
Factory default settings 57
Frame rates 25, 70
FTP server 37
Full duplex 29, 30

H
Half duplex 29, 30
Host name 52
HTML examples 36
HTTP API 34, 45
HTTP port number 53
HTTP server 37
HTTP-API 22
HTTPS 50

I
I/O Ports 55
I/O terminal connector 9
Include windows 40
Installation methods 10
Installing PTZ devices 42
Internal video sources 16
IP address filtering 49

L
Live view config 33
Live View page 23
Logs & Reports 56

M
Maximum bandwidth 53
Motion detection 40
Motion JPEG 18, 21
Mounting 10
MPEG-4 18, 22
MPEG-4 clients 21
MPEG-4 protocols 19
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MPEG-4 settings 54
Multicasting 19

N
Network settings 51
Network traffic 53
Notification of IP address change 51

O
Operators 49
Output buttons 16, 35
Overlays 25, 29
Own home page 34
Own web files 34

P
Pan/Tilt/Zoom 44
Port status 41
Ports & Devices 54
Post-trigger buffer 39
Preset positions 46
Pre-trigger buffer 39
PTZ commands 34, 45
PTZ control queue 47
Pulse 16, 35
Push to talk 30

Q
Quad stream 28

R
Recovery 62
Referrals 49
Relative and absolute PTZ drivers 44
Restart 55
Restore 55
RTP 19, 54
RTSP 19, 53

S
Scheduled event 37
Security 49
Sequence mode 16, 36

Services 51
Set the IP address 10
Simplex 29
SMTP settings 54
Snapshot 17
SOCKS server 53
Specifications 66
Streaming MPEG-4 20
Support 56
Synchronization 22
System options 49

T
TCP server 37
TCP/IP settings 51
Triggered event 37
Troubleshooting 61

U
UDP 19
Unicasting 19
Upgrade Server 55
UPnP 54
User defined links 34
Users 49

V
Variable bit rate 18
Video output 9
Video source 16, 25
Video streams 18, 21, 25
View size 16
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